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Click a measurement icon to
take a measurement of the

currently selected waveform.

To Use the Screen Controls

Use the mouse to select waveforms, menus, and buttons. You can also
drag with the mouse where indicated below.

Drag the horizontal reference to move
the point around which horizontal scaling
expands and contracts the waveforms.

Drag across a waveform segment
and click the Zoom button to expand

the selected waveform segment
horizontally to full-screen width.

� Right click on display items and readouts to find set-up
shortcuts and additional options.

� Use the touch screen to make selections if a mouse is not
available. Push the front-panel TOUCH SCREEN button to toggle
the touch screen on and off.

� When using the touch screen, you can use your finger or the
touch-screen stylus that shipped with the product.

Other Navigation Tips:

Drag the zero-reference indicator
to add offset to a waveform.

Copyright� Tektronix, Inc.

Drag waveform icon vertically to
position the waveform vertically.



Push a MENU button to
access the setup dialog box

for that control group.

To Access the Setup Dialog Boxes

Click the Setups icon to access
the setup dialog boxes with the

one last active selected.

Access any setup dialog
box from the Setup menu.

Push the SETUP DIALOGS
button to access the last
active setup dialog box.

Click on the tabs to
select among the

setup dialog boxes.



To Display a Communication Signal

Carefully install the sampling module in the
instrument.

Note. After installing a sampling module(s) or
after moving the module from one compartment
to another, run compensation (Utilities menu) to
ensure the instrument meets its specifications.

See your user manual for more information.

1

CAUTION. To prevent damage, make sure instrument power is turned off before
installing sampling modules. To help prevent damage from ESD, always attach
and use the wrist strap while making any electrical signal connections.

Trigger

Communication signal

Select the communication

standard.
4

Click Autoset in the Mask setup

dialog box or on the front panel.
5

Select the channel that you want to

display in the Mask setup dialog box. 3

� Install up to two optical modules into the large-module compartments. These
optical inputs become channel 1 and channel 2. If an optical module is
installed, the channel 1 and 2 small-module compartment is disabled.

� Use the Optical Clock Recovery option to obtain a stable trigger from an optical
data signal when using optical sampling modules that support clock recovery.

To Display Optical Signals:

Connect signals to your

sampling module.
2



To See More Waveform Detail

Drag across the segment of the waveform

that you want to see in greater detail.
1

Click these buttons to add one or

two magnified time base views.
1

Click the Zoom button. 2

To Add Magnified Views

Drag the brackets in the main time

base to specify the position and scale
for the magnified view.

2

Click a button to select among the

displayed views. Horizontal scale,
position, and other controls operate

on the selected time base view.

4

Mag View

Main View

Click the magnified time base button again

to remove that view from the display. (First
click selects; the second removes.)

5

See the waveform reacquired with
increased horizontal resolution.

3

Drag the boundary between two
graticules to resize the graticules.
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To Analyze Communication Signals

If you want, disable mask counts.
(Selecting a mask in step 2

automatically enabled them.)

3

Read the mask-hits
count in the readout.

5
Specify a stop condition in the Acquisition

setup dialog box, and then specify an action
to take place when acquisition stops. (You
can set counts for the Mask Hits condition

here also.)

6

Use Mask Testing

Use FrameScan�

Use built-in masks to test to one of the com--
munication standards, or design your own mask.

Use FrameScan to test a specific bit (or
range of bits) in a repeating frame of data.

You set up FrameScan from the Horizontal
Setup Dialog box. See the instrument user

manual for more information.

Frame sync pulse

Repeating data stream

Set the start bit and the number of bits
within the frame that you want to analyze

in the Horizontal setup dialog box.

Select a standard mask in the Mask setup
dialog box.

2

If you want, you can enable margins
to explore design margins of your

communications signal.

4

1Select a channel to mask test.



To Take Measurements With Cursors

Push the CURSORS button to turn on the cursors
to measure the currently selected waveform. 1

You can also drag each cursor to
place it relative to the waveform.

5

Cursor
readouts

� You can assign each cursor to a different waveform to take
measurements between waveforms. Make these selections in the Cursor
setup dialog box.

� If you use two magnified time base views, you can take precision timing
measurements between two distant points on a waveform. Magnify each
point of interest in a separate time base, and then place one cursor on
each point. The ∆-time cursor readout will then reflect the position and
resolution of the magnified time bases.

Other Cursor Measurement Tips:

Click this button to toggle the
cursor readouts on and off.

6

Push the CURSORS button repeatedly to
toggle between cursor type: Vertical Bars,

Horizontal Bars, Waveform, and Off.
2

Push the SELECT button to toggle selection of
the active (adjustable) cursor between the pair.

Position the active cursor with the General
Purpose knob.

4

3



Amplitude Area Timing

AC RMS Cycle Mean Eye Open-
ing Factor

Mid Q Factor Suppression
Ratio (dB)

Area Bit Rate Delay Frequency + Width

Amplitude Cycle RMS Gain Min RMS OMA Area Cycle Bit Time + Duty Cycle Period -- Width

Avg. Optical
Power (dBm)

Extinction
Ratio

High + Overshoot RMS Noise Burst Width -- Duty Cycle Phase

Avg. Optical
Power (watts)

Extinction
Ratio (%)

Low -- Overshoot Signal-to-
Noise Ratio

+ Cross Duty Cycle
Distortion

Pk-Pk Jitter

Crossing % Extinction
Ratio (dB)

Max Pk-Pk Suppression
Ratio

-- Cross Eye Width Rise Time

Crossing
Level

Eye Height Mean Pk-Pk Noise Suppression
Ratio (%)

Crossing
Time

Fall Time RMS Jitter

Note: All measurements are accessible from the Meas Setup dialog box. Some measurements are not accessible from the Meas. Toolbar at top of the display.

To Take Automatic Measurements

Select the measurement signal type. 1

Click a measurement button to take
the measurement on the currently

selected waveform.

3

Or completely set up the measurement
in the Meas setup dialog box.

4

5Read the measurement results
in the readouts.

The dialog box readout displays
results with full resolution.

Automatic Measurement Choices

Select the measurement category. 2



Select Region tab and turn on gates
to isolate the measurement to a
specific part of the waveform.

To Customize an Automatic Measurement

Select the RefLevel tab and adjust the
measurement reference levels to different

relative or different absolute values. You can
also select AOP, to have the instrument
measure and use the Average Optical

Power level of the signal as a reference
level (useful for OMA measurements).

Select Annotations to see where
the measurement is being taken

on the waveform.

Select the HiLow tab and choose a
method for determining reference levels.

Select Statistics to see accumulated
statistics as the measurement is

being performed.



To Use Math Waveforms

Math expressions can combine waveforms with
measurement results, as shown in this example

(C1 minus the mean value of C1).

Click the f
x
button to display the

Define Math dialog box.
1

Select the math waveform you want to define. 2

Define Meas1 as the Mean value of
C1 in the Meas setup dialog box.

1

Enter this sequence in the Define
Math dialog box to build the math

waveform expression.

2

A Math Waveform Example

Use the controls in the Define Math dialog
box to define the math expression. Build
the waveform expression using sources,

operators, constants, and functions.

3

4Click to check the On box to display
the math waveform.

Result:
, ,



4

To Use TDR

Attach your network to TDR-capable
sampling modules.

1

2

CAUTION. To help prevent damage from
ESD, always attach and use the wrist
strap while making electrical signal
connections.

Click the Preset button to automatically
display the incident and reflected steps by

automating the following tasks:

5

Set the vertical scale Units to
V (volts), Ω (ohms), or ρ (rho).

Click the polarity button to toggle the
step edge to the polarity you chose.

If performing differential TDR, select a channel
pair for deskew adjustment from the pulldown list

(even numbered channel gets adjusted).

3

6

7

Then use the box arrows (or click the
keypad icon and use a virtual keypad) to

set the deskew percent value.

Select an internal clock rate from the pulldown
list. The instrument will generate TDR pulses at

this rate. Use a lower clock rate to examine
long cables or other interconnections.

� Turns on the channel

� Turns on a step

� Does a TDR autoset



To Use Histograms

Select and enable a vertical or horizontal
histogram in the Hist(ogram) setup dialog box.

To Use Color Grading

The histogram displays at the edge of
the graticule. The histogram statistics

are displayed in the readout.

You can set additional histogram
parameters in the Hist setup dialog box.

Click here to assign the selected waveform to an
internal waveform database and to display the
waveform using color grading. Click the button

again to toggle display of color grading off.

1

Click and drag the edges of the histogram
box to enclose a portion of the waveform.

2

3

Set count emphasis. Higher values increasingly
emphasize the count differences between the

samples with high and low counts in the display.

Choose between varying color or intensity of
the waveform database to indicate how often a

data point occurs.

1

3

4

Choose to display waveform data with infinite
accumulation (infinite persistence) or with

accumulation based on a maximum waveform
count that you set (variable persistence).

2



To Document Your Results

To Save a setup or a waveform, click Save
Setup or Save Waveform in the File menu.

To export waveform data into a
comma-separated ASCII file, click
Export Waveform in the File menu.

To print a hard copy to an attached printer or a
network printer, click the print icon in the

toolbar. If necessary, you can make changes
to the page orientation in the Page Setup
dialog box, and you can select Ink-saver

mode, to save ink when printing.

To copy a screen image into another
application, choose the Print to file option in
the print dialog. Save the screen image in a

format that is compatible with your
application, and then insert the screen

image into your document.



To Access the Help System

Tool tips automatically identify many screen
controls when you point to them with the mouse.

1

Click the What’s This? icon in the main
window or the icon in a dialog box and then

click on any screen element.

2

Click the Help button in a setup dialog box to
get help on that particular setup.

4

Click the Help menu in the UI application
menu bar to access the Table of Contents
and the Index of the help system. If you

have a keyboard, you can enter keywords
to search for a help topic.

3

You can also right click on an element in any
setup dialog box to access What’s This? help

on that element.

A small window appears that provides a brief
description and sometimes links to additional

information about the screen element.



RJ-45 connector to connect to network

To Use Instrument I/O

Floppy disk drive accessible
from Windows 98

On the Front Panel

Removable hard disk drive to provide
individual environment for each user or to

secure data, press to release

Compartments for large
modules, up to two channels

On the Rear Panel

USB connector for mouse or
keyboard and mouse

COM1 serial port

Upper VGA port to connect a
monitor for dual-monitor display

Lower VGA port to connect a
monitor for instrument display

PS-2 connectors for mouse and keyboard

Parallel port (Centronics) to
connect printer or other device

GPIB port to connect to controller

PCMCIA slots for two type-1 cards,
two type-2 cards, or one type-3 card

CDROM drive accessible from
Windows 98, press to open

Compartments for small
modules, up to eight channels

Antistatic connection for wrist
strap, 1 MΩ to ground Trigger

Prescale
Input

Trigger
Direct
Input

Trigger
Probe
Power

DC Calibration Output

Internal Clock Output

External 10 MHz Reference Input

Accommodates optical and
electrical modules:

TRIGGER GATE (TTL)




